
WHAT'S NEW IN
MASTERCAM 2020

March 2019



WHAT'S NEW IN MASTERCAM 2020

March 2019
© 2019 CNC Software, Inc. – All rights reserved.
Software: Mastercam2020

Terms of Use
Use of this document is subject to the MastercamEnd User License Agreement. The MastercamEnd User License
Agreement can be found at:

http://www.mastercam.com/companyinfo/legal/LicenseAgreement.aspx

Be sure you have the latest information!
Informationmight have changed or been added since this document was published. The latest version of the
document is installed withMastercamor can be obtained from your local Reseller. A ReadMe file (ReadMe.PDF) –
installed with each release – includes the latest information about Mastercam features and enhancements.

ii

http://www.mastercam.com/companyinfo/legal/LicenseAgreement.aspx


TABLE OF CONTENTS

Introduction 9

Release Highlights 9

Masters of CAM™ 9

OpenCL Warning 9

MastercamResources 10

Contact Us 10

General Enhancements 11

Analyze Enhancements 11

Analyze Entity 11

Check Solids 13

Volume Information for ClosedMesh Parts 14

Chaining Enhancements 14

Chaining Tangent Entities 14

Unselect and Previous 15

Solid Chaining 15

Bosses and Cavities 16

Convert to Edges and Convert to Loops 16

Face Selection Options 17

Linked Edges 18

Additional Enhancements 18

Wireframe Chaining 19

Additional Enhancements 19

Code Expert Enhancements 20

Improved Support for Multi-streamOutput 20

New Search Functions 21

Contextual Ribbon Tabs 21

Deleting Referenced Entities 23

iii



File Importers 25

Imported 3D Annotations 25

STL Exports 25

Additional File Support Enhancements 25

Graphics Support 26

Machine Definition and Component Files 26

Mastercam Folder Locations 26

Mastercam Simulator Enhancements 27

Rotary Axis Positioning 29

Merge Pattern 30

Position 30

Levels 30

Attribute Settings 31

PlanesManager 31

Persistent Plane Display 31

Find a Plane 32

Fit Origin 32

Plane Gnomon Enhancements 33

ShowGnomons 34

Selection Enhancements 35

AutoCursor® Settings Renamed Selection Settings 35

Face Center 36

Tangent Selection 36

SystemConfiguration 37

Chain Highlighting 37

Color Options 37

Translucent View 39

ToolpathsManager 39

Highlight Geometry 39

Dependencies 40

iv



Additional Enhancements 40

Design Enhancements 42

Edit Surface and Edit Spline 42

Multiple Node and Control Point Selection 42

Gnomon Control 42

Curvature Comb 42

Hole Table 43

Selection 44

Display and Position 44

Reporting 44

TrueType® Fonts 44

Model Prep Enhancements 45

Add History 45

Align to Face 45

Push-Pull 45

Power Surface 46

Solids Enhancements 47

Boolean 47

Solid Hole 47

Assign Colors 47

Associativity 48

New Selection Controls 48

Top Chamfer Input 48

Wireframe Enhancements 49

Curve Enhancements 49

Curve All Edges 49

Curve Flowline 49

Curve Slice 49

Divide 50

Trim Functions 50

v



Additional Enhancements 50

Mill Enhancements 51

Accelerated Finishing™ Tools 51

Additional Catalog Properties 52

Hole-making Enhancements 53

Toolpath Hole Definition 54

2D Enhancements 56

Advanced Toolpath Display 56

Override Geometry Diameter 56

Spring Passes and Overlap 57

3D Enhancements 57

Curve Support 57

Dragging and Dropping Toolpath Geometry 58

New3D Blend Toolpath 59

Offset Strategy 59

Silhouette Boundary 61

Tool Containment 62

Z Depth Enhancements 63

Multiaxis Enhancements 64

Deburr 64

Swarf Milling 64

Additional Enhancements 65

Lathe Enhancements 66

3D Tooling 66

Insert Designer 67

Holder Designer 68

Filters for Inserts and Holders 68

Improved Chuck JawDefinitions 70

Mill-Turn Enhancements 73

ImprovedMachine ConfigurationWorkflow 73

vi



NewMachine Configuration Page 73

New Tool Locator and Component Library Functionality 74

New Interface for LocalMachine Definitions 76

Post Enhancements 78

MPBin Enhancements 78

MP Post Enhancements 78

Improved language support for post text 78

Improved support for UTF-8 encoding for MP posts 79

vii



viii



9

INTRODUCTION

Welcome to Mastercam2020! Mastercam2020 features new functionality focused on delivering speed and efficiency
to your machining jobs.

Release Highlights
Listed below are some of the highlights for Mastercam2020, including new toolpaths and enhanced functionality.

l "New 3D Blend Toolpath" on page 59

l "Hole Table" on page 43

l "3D Tooling" on page 66

l "Filters for Inserts and Holders" on page 68

l "ImprovedMachine ConfigurationWorkflow" on page 73

Masters of CAM™
As the world’smost widely used CAM software, Mastercamhas a tremendous community of users around the globe. It
is our intention to leverage that combined energy and intelligence for our mutual benefit. That is the heart of our new
Masters of CAM initiative.

Over the coming weeks, months, and years, we will be collecting stories, tips, tricks, and
solutions fromour extendedMastercam community. This input will be available to
everyone.

We will be collecting asmany good ideas as we can to stay competitive with the growing
market. Some ideas will help your shop’s productivity. Some ideas will inspire creativity.
And some ideasmay direct our future software development. We know a lot of smart
Mastercamusers, and we are all smarter whenwe work together.

Our Masters of CAM programwill grow in breadth and depth over time. Visit MastersofCAM.comand see what
amazing things people are making. Then share a story of your own.

OpenCL Warning
When you launchMastercam2020 youmay receive awarningmessage about minimum system requirements for
OpenCL™. By receiving this warningmessage, it means that your computer's video card does not support OpenCL.

As of Mastercam2020 you can acknowledgment the warningmessage, and continue runningMastercam. However, in
a future Mastercam release youmay be required to use a graphics card that does support OpenCL. For more
information about the warning, troubleshooting, or updating your drivers, please refer to the Mastercam
Knowledgebase (https://kb.mastercam.com/).
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Mastercam Resources
Enhance your Mastercamexperience by using the following resources:

l Mastercam Documentation—Mastercam installs a number of helpful documents for your version of software in
the Documentation folder of your Mastercam2020 installation.

l Mastercam Help—AccessMastercamHelp by selectingHelp, Contents fromMastercam's File tab or by
pressing [Alt+H] on your keyboard.

l Mastercam Reseller—Your localMastercamReseller can help withmost questions about Mastercam.

l Technical Support—Our Technical Support department (+1 860-875-5006 or support@mastercam.com) is open
Monday through Friday from8:00 a.m. to 5:30 p.m. USA Eastern Standard Time.

l Mastercam Tutorials—We offer a series of tutorials to help registered users become familiar with basic
Mastercam features and functions. Visit our website, or select Help, Tutorials fromMastercam's File tab to see
the latest publications.

l Mastercam University—MastercamUniversity, an affordable online learning platform, gives you 24/7 access to
Mastercam trainingmaterials. Take advantage of more than 180 videos to master skills at your own pace and
help prepare for MastercamCertification. For more information onMastercamUniversity, please contact your
AuthorizedMastercamReseller, visit university.mastercam.com/, or email training@mastercam.com.

l Online Communities—You can find awealth of information at www.mastercam.com.

l Follow us on Facebook (www.facebook.com/Mastercam), Twitter (twitter.com/Mastercam), and
Instagram (www.instagram.com/mastercamcadcam/) for the latest tech tips andMastercamnews.

l See Mastercam in action on YouTube (www.youtube.com/user/MastercamCadCam).

l For more information on CNC Software, Inc., to find and apply to jobs, and connect with people using
Mastercam, visit us on LinkedIn (www.linkedin.com/company/cnc-software/).

l Registered users can search for information or ask questions on the MastercamWeb forum,
forum.mastercam.com, or use the MastercamKnowledgebase at kb.mastercam.com.

Contact Us
For questions about this or other Mastercamdocumentation, contact the Technical Documentation department by
email at techdocs@mastercam.com.

What's New in Mastercam 2020—Introduction
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GENERAL ENHANCEMENTS

Listed below are general enhancementsmade to Mastercam2020. This includes improvements to selection and other
functions not specific to one product line.

Analyze Enhancements
Listed below are enhancementsmade to the Analyze functions on the Home tab.

Analyze Entity
Analyze Entity now includes additional information about associated geometry and operations. Click Association in the
Analyze Properties dialog box to check for association to a solid, toolpath, plane, dimension, 3D annotations, or
group. This button displays if the analyzed entity has associated geometry or operations.

What's New in Mastercam 2020—General Enhancements



In previous releases, importedModel Based Definition (MBD) data displayed by Analyze Entity was limited to name,
type, referenced entity, and presentation graphic information. InMastercam2020, Analyze Entity also includes the
part's semantic data, such as tolerance values and sub-types.

Analyze Entity also includes a Flip button, allowing you to reverse the start and end points of the selected line, spline,
or arc.

What's New in Mastercam 2020—General Enhancements
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Check Solids
Check Solids will now check for tolerant edges and give amore detailed report in the Check Solid dialog box to help
you locate any issues your part may have. The dialog box will also display a list of errors, even if not all of the entities
are displayed.

Mastercam 2019 Mastercam 2020
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Volume Information for Closed Mesh Parts
The Polygonal Mesh Properties dialog box now includes a Properties button. This opens the Solid Properties dialog
box so you can view the following:

l Solid volume andmass relative to a defined density

l Center of gravity

l Moment of inertia relative to a selected axis line

Additionally, you can save solid data to a file.

Chaining Enhancements
Enhancements have beenmade to chaining and the Chaining dialog box for Mastercam2020. These include:

l Improved Chaining dialog box layout for bothWireframe and Solidsmode.

l Chain display and behavior improvements, including new configuration settings for chain color and line style.

l Removed the expand arrow from the upper left corner of the Chaining dialog box andmoved the parameters
to the main dialog box.

Chaining Tangent Entities
You can now automatically chain tangent entities or tangent edges by holding the [Shift] key while selecting an entity
or edge. Chain tangent entities or edgeswhen at a branch point by holding [Shift] while clicking a chain arrow, the
Previous button, or the Next button. Control the angle used to determine tangency of entities using the new
Chaining tangency tolerance option.

What's New in Mastercam 2020—General Enhancements
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Unselect and Previous

The Unselect button now removes the last selected chain rather than the last
entity of a linked edges chain when in Solidmode. Unselect andUnselect all
behavior has improved during guided chaining for Wireframe mode.

A newbutton, Previous, removes one branch or entity at a time when creating a
linked edges chain in Solidmode. Clicking this buttonmoves the endpoint of a
solid edges chain to the previous branch point. InWireframe mode, clicking the
Previous buttonmoves the endpoint of a chain to the previous branch point.

Solid Chaining
The following images depict the enhancementsmade to the Chaining dialog box when in Solidmode. Details of the
enhancements follow.

Mastercam 2019 Mastercam 2020
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Bosses and Cavities

Two new selection options are available in Chaining dialog box:

l Bosses: Selects only bosses on the selected face.

l Cavities: Selects only cavities in the selected face. Use the Cavities drop-down to filter by Blind or Through
cavities.

Convert to Edges and Convert to Loops

Two newoptions, Convert to edges and Convert to loops are available when right-clicking on a loop, face, or partial
loop chain for Convert to edges or a face chain for Convert to loops in the ChainManager.

What's New in Mastercam 2020—General Enhancements
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For example, after selecting Convert to edges, the face chain is converted to an edges chain.

NOTE
Any associativity will be lost after converting.

Face Selection Options

When selecting faces for solid chaining, the following shortcut keys (hotkeys) are available:

l [Shift+click]—Selects tangent solid faces.

l [Alt+click]—Selects vectors.

l [Ctrl+click]—Selectsmatching solid fillets and/or holes.

l [Ctrl+Shift+click]—Selects similar solid features.

You can also window select solid faces.
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Linked Edges

The Edge option has been removed. Linked Edges has beenmoved and renamed Edges. The Edges option combines
the functionality of Edge and Linked Edges. These changes also apply to the Chain Manager dialog box.

Additional Enhancements

l You can now edit solid chains in the ChainManager by right-clicking a chain and selecting Edit.

l When chaining edges, you can now start a new chain by clicking an edge that is not part of the current chain.

l You can create partial loop chains acrossmultiple solid bodies in the same chaining session.

What's New in Mastercam 2020—General Enhancements
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Wireframe Chaining
The following images depict the enhancementsmade to the Chaining dialog box when inWireframe mode. Details of
the enhancements follow.

Mastercam 2019 Mastercam 2020

Additional Enhancements

l You can now adjust the start point for open chains.

l You can now start a new chain by clicking an entity that is not part of the current chain.

l You can create multiple disconnected chains in the same wireframe chaining session.

l The Start and End buttons are now available for Partial chaining.

l Chains with branch points now respect the cursor location for the start point.
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Code Expert Enhancements
Listed below are enhancements for Code Expert.

Improved Support for Multi-stream Output
Code Expert includes several new features for working withmulti-streamNC files withMill-Turn.

l New controls let you toggle between single-streamandmulti-stream viewwithout re-posting.

l NewAlign Syncs function displaysmulti-streamoutputs with the syncs or wait codes lined up. You can also select
the colors that will be used to highlight the syncs.

l NewSave All function lets you save all the NC files associated with amulti-streamdocument instead of needing
to save each file individually.

What's New in Mastercam 2020—General Enhancements
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New Search Functions
The search function in Code Expert includes two new features: 

l Recall previous searches by clicking the arrownext to the search term field. The previous search terms are
saved per Code Expert session.

l You can choose to search backward instead of forward by clicking the new Find Previous button.

Contextual Ribbon Tabs
To speed up design changes to your parts, Mastercam2020 includes contextual ribbon tabs that display when you
select different types of geometry in the graphics window. For example, if you select only wireframe geometry, an
extra ribbon tab titledWireframe Selection displays tools that youmight need for analyzing or editing.

Similar tabs display when you select solid, surface, mesh, or amixture of geometry types.
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You can customize the tools that display on these ribbon tabs by going to File, Options, Customize Ribbon. Select
Tool Tabs from the Customize the Ribbon column on the right side to see the selection tabs.

Add your own functions to the ribbon tabs, or remove groups of functions. To turn off these contextual ribbon tabs,
deselect the Tools checkbox at the top of the list for the geometry type.

What's New in Mastercam 2020—General Enhancements
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Deleting Referenced Entities
In previous versions, Mastercamwould display the Deleting a referenced entity dialog box if the geometry selected
for deletion included references to other entities. However, the actions of this dialog were limited to deleting all
selected entities or deleting only non-associative entities. Moreover, you were unable to locate the geometry or
references entities in the graphics window.

For Mastercam2020, this dialog box has been enhanced so that you can visualize and have more control over your
deletions.

The Show associative entities button displays a list of all the referenced geometry that you have selected to delete.
The tree-style control shows the association between selected geometry and referenced planes, toolpaths, solids, or
entities. You can resize the dialog box to show asmuch or as little of the list as you like.

Use the [Up] and [Down] arrow keys or the scroll bar to navigate through the list. If you select an entity in the list,
Mastercam locates it in the graphics window and highlights its references to toolpaths, solids, or planes.

Select the Display only associated entities in graphics window option to simplify what displays in the graphics
window.
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Right-click an entity and select Isolate to temporarily display only that entity in the graphics window, Analyze to get
more information, or Remove to remove it from the list.

What's New in Mastercam 2020—General Enhancements
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File Importers
Below are enhancementsmade to file importers for Mastercam2020.

Imported 3D Annotations
The 3D annotations in imported Unigraphics/Seimens NX™, ProE/Creo™, STEP, Inventor, and CATIA™ files nowpoint
to the referenced geometry. InMastercam2019, this was only supported in imported STEP files.

STL Exports
In previous releases, Mastercamexported STL datawith the same units used in the current Mastercam session. In
Mastercam2020, aUnit drop-down has been added to the Save as an STL File dialog box and to the
Configuration/Converters page in the System Configuration dialog box. Use this parameter to include unit data
when exporting to software packages that require it, such as software that interfaces with certain 3D printers.

Additional File Support Enhancements
l You can now import Rhino 6, Solid Edge 2019, Catia V5 R28, and SOLIDWORKS 2019 files.

l Support for Spatial 2019 1.0 files when importing ACIS .SAT and .SAB files.

l Support for importing coordinate systems from .STEP, ProE/Creo, and Unigraphics/NX files. These coordinate
systemswill come into Mastercamas named planes.

l The ProE/Creo file imported has been enhanced, yielding better results for most files and allows for the import
of 3D annotations.
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Graphics Support
The Hardware acceleration option has beenmoved from the Graphics Support page in theMastercam Advanced
Configuration dialog box to theMastercam Launcher dialog box, accessible from the Mastercam2020 Start menu
folder.

Machine Definition and Component Files
The Machine Definition and component files (*.mcam-mmd, *.mcam-lmd, *.mcam-rmd, *.mcam-wmd, and *.mcam-gmd)
nowopen directly into the Machine DefinitionManager or the Control DefinitionManager when usingWindows
Explorer or a command line. Previously, the files opened as aMastercampart file that required you to open the
Machine DefinitionManager or Control DefinitionManager as an additional step.

Mastercam Folder Locations
In previous versions, Mastercamused the following default names and locations for installed folders:

Folder name Default folder location

mymcam2019 C:\Users\User name\Documents

shared Mcam2019 C:\Users\Public\Documents

Mcam2019 C:\Program Files

For Mastercam2020, the file structures have changed.

What's New in Mastercam 2020—General Enhancements
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If you have MastercamandMastercam for SOLIDWORKS installed, both products nowuse the same root folder. If you
only have one product installed, only that product folder will be in the root folder.

Folder name Contains Default folder location

My Mastercam 2020
l Mastercam

l Mastercam for SOLIDWORKS
C:\Users\User name\Documents

Shared Mastercam 2020
l Shared files and folders for all 2020
products.

C:\Users\Public\Documents

Mastercam 2020
l Mastercam

l Mastercam for SOLIDWORKS
C:\Program Files

Mastercam Simulator Enhancements
Listed below are enhancementsmade to Mastercam Simulator.

l Two newoptions have been added to the Simulator page in the System Configuration dialog box:

l Go to home position on tool plane change: Moves the tool to a home position between operations
when there is a plane change.

l Simulate disabled posting: Enables the simulation of operations for which posting has been disabled.

l The Use Mastercam colors option, available on the Graphics page, will inherit colors set inMastercamand the
color settings inMastercam Simulator will be disabled.

l Mastercam Simulator now colors workpieces, including those made up of several different models (surfaces,
solids, or meshes), as one singular color making it easier to identify themduring sessions.
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l The stockmodel color that is set on the Stock Definition page of the Stock model dialog box nowdisplays in
Mastercam Simulator.

l Edge highlighting has been improved for stockmodels, workpieces, and fixtures.

What's New in Mastercam 2020—General Enhancements
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l In previousMastercam versions, Mastercam Simulator displayed collisions when verifying back feed
rate/microlift toolmotion. Microlift moves are now correctly checked and will be identified inMastercam
Simulator if they encounter material.

Rotary Axis Positioning
Mastercam Simulator, when using Verifymode, now simulates the Rotary axis positioning option located on the
Rotary Axis Control page of toolpaths. This allows you to simulate and visualize multiaxismovement of the machine
tool. When this option is enabled, Mastercam Simulator will:

l Display the rotation of stock between tool planes.

l Display the tool axis orientation.

l Display cuttingmoves in the rotated tool plane.
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Merge Pattern
The Merge Pattern function (accessed by selectingMerge on the File tab) has been improved for Mastercam2020.

Position
You can nowuse Align to Face or select a transformmethod (Dynamic, Mirror, or Scale) to position the merged part
geometry. Mastercamapplies the result color to the merged geometry so it is easy to identify for further editing.

The Reselect button has been renamed Select, but retains the same functionality seen in previous versions of
Mastercam.

Levels
In previous versions of Mastercam, you were limited to merging part geometry into the active level. For Mastercam
2020, you can choose onwhich levelmerged geometry will be placed.

The new Levels group on theMerge Pattern function panel has three options:

l Active level: Merges part geometry into the current file's active level.

l Merged file levels: Merged part geometry remains on its original levels.

l Offset by: Mastercamplaces the merged part geometry on new levels whose numbers are offset by the value
entered in the field. The merged part geometry stays separate from the target part geometry.

What's New in Mastercam 2020—General Enhancements
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Mastercamapplies your level preferences after you clickOK or OK and Create new operation. Merge Pattern
accounts for any levelmodifications youmake to the Levels option when you use the Dynamic, Mirror, or Scale
methods to position the geometry. However, if you select Active levels, Mastercam ignores these modifications and
merges the part geometry into the original part's active level.

Attribute Settings
You nowhave more control over the attributes of your merged part. In previousMastercam releases, the Use
current attributes checkbox applied only the system color and level to the merged part. InMastercam2020, you
can now apply the current systemattributes for color, level, line style, point style, and line width to the entities in your
merge part.

Planes Manager
Listed below are enhancements that have beenmade to the PlanesManager for Mastercam2020.

Persistent Plane Display
In previousMastercam versions, the Display column in the PlanesManager determined which planes display when
using Find plane, From plane. In Mastercam2020, this column controls which plane gnomons display in the graphics
areawhen the Show Gnomons button is toggled on.

If you select the Display column for a plane, an "X" will appear in the column. With the Show Gnomons button
toggled on, the gnomon for each plane that contains an "X" in the Display columnwill remain on the screen. By
selecting the Display column again (removing the "X"), the gnomonwill no longer display on the graphics window.
With the Show Gnomons button toggled off, all gnomons are removed from the graphics window, even if the
Display column is selected.
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Find a Plane
The Find a plane, From plane option now includes the following options:

l All: Displays all plane gnomons and prompts you
to select one in the graphics window.

l Selected: Displays all gnomons for the planes
selected in the PlanesManager and then
prompts you to select one in the graphics
window.

l Displayed: Displays only the gnomons for the
planes that have the Display column selected
and prompts you to select from the graphics
window.

Fit Origin
A newoption, Fit origin, is available in the right-click menu of the PlanesManager. Fit origin will fit both your part and
the origin of the selected plane in the graphics window.

What's New in Mastercam 2020—General Enhancements
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Plane Gnomon Enhancements
The Plane Gnomon Settings dialog box includes newoptions to control the display of the plane gnomons.

Use the Opacity slider under Axes display to control the opacity of the plane gnomon axes. Additionally, when Show
Gnomons is toggled on, the follow options are active: 

l You can hover over an individual plane to highlight it in the graphics window. Any other displayed plane
gnomons are dimmed.
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l Select Only when highlighted to display the plane of a gnomonwhen the gnomon is highlighted in the
graphics window.

l You can right-click on a plane gnomon to access functionality without having to reopen the PlanesManager.

Show Gnomons
In previousMastercam versions, the Show Gnomons button contained a drop-down that controlled the display of the
WCS, Cplane, and Tplane gnomons. This button was only available on the View tab.

InMastercam2020, Show Gnomons has also been added to the PlanesManager with these newoptions:

l WCS: Displays a static plane gnomon at the WCS origin, rather than a single color gnomon.

l Cplane: Displays a static plane gnomon at the Cplane origin.

What's New in Mastercam 2020—General Enhancements
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l Tplane: Displays a static plane gnomon at the Tplane origin.

Additionally, the Always display gnomon option has beenmoved from the Display Optionsmenu to the Show
Gnomonsmenu and has been renamed Selected planes. This option has the same functionality as it did in previous
versions. When Selected planes is selected and Show Gnomons is toggled on, the gnomons for all selected planes
will always display in the graphics window.

Selection Enhancements

AutoCursor® Settings Renamed Selection Settings
The AutoCursor Settings dialog box, opened by selecting AutoCursor Configuration on the Selection Bar, has been
renamed Selection and added to the System Configuration dialog box. The option on the Selection Bar has also
been renamed to reflect this change.
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Face Center
AutoCursor now supports a face center override mode that places the AutoCursor at the center of gravity of the
selected face. Select Face Center from the AutoCursor drop-down on the Selection Bar, or press [F] to activate this
override.

Tangent Selection
A newoption, Tangency Tolerance has been added to the Selection page of the System Configuration dialog box.
In previous releases, when expanding a selection to tangent faces or edges, the tolerance was limited to neighboring
entities that aligned with the selected entity. Mastercamdid not recognize a neighboring entity as tangent if the angle
variation was greater than 0. This newoption allows you to expand the entities that Mastercam recognizes as tangent
by entering in a value.

What's New in Mastercam 2020—General Enhancements
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System Configuration
Listed below are enhancements to options found in the System Configuration dialog box, accessed from the File tab.

Chain Highlighting
When viewing chains in the ChainManager, the chains are highlighted in the graphics window. In previous versions of
Mastercam, you could not control the color of this highlight. InMastercam2020, you can use Chain highlight in the
Colors page to control the highlight color.

Color Options
Expanded color options are available in the System Configuration dialog box. These colors display in various areas of
Mastercam.
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Use the Tools and holder page to set colors for lathe, mill, and router tools .

Use the Simulation Display page to set colors for collisions, fixtures, and sections. These colors only apply to
Mastercam Simulator.

What's New in Mastercam 2020—General Enhancements
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Translucent View
You can now change the opacity level when Translucency (on the View tab) is toggled on. Use the Opacity slider
under Translucent view on the Shading page tomake adjustments.

Toolpaths Manager
Listed below are enhancementsmade to the ToolpathsManager.

Highlight Geometry
The Highlight geometry group, which was removed in a previousMastercam version, has been returned to the
Display Options dialog box.

When selected,Wireframe,Machining, or Avoidance geometry is highlighted by the chosen color for the selected
toolpath.
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Dependencies
The Dependencies group has beenmoved from the Display Options dialog box to the ToolpathsManager toolbar.
The newDependencies toggle allows you to pick one or both of the following:

l Selection: Selects all dependent operations when you select the parent operation.

l Regeneration: Regenerates all dependent operations when you regenerate the parent operation, even if the
dependent operations are not selected.

To enable these options, select one or both options from the Dependencies drop-down. Then select the
Dependencies button to toggle the selected option on. Select again to disable the options.

When enabled, the button has a dark background.

Additional Enhancements
l The Dynamic gnomon can now change between 2D and 3D mode. Use the Change gnomon style based on
2D/3D Cplane option in the Gnomon Settings dialog box to control this. This option is on by default. Right-click
the Dynamic gnomonwhen you are using it in the graphics window to display the Gnomon Settings dialog box.

l You can toggle the display of the screen unit and scale by selectingDisplay unit/scale on the Screen page in
the System Configuration dialog box.

What's New in Mastercam 2020—General Enhancements
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l You can print a label for each instance of a part on a nested sheet. Select Create label data for each nested
part on the Options dialog box for Automatic Toolpathing (ATP).

l The Arc Center Points option on the Home tab is now toggled off by default. Also, when toggled on, the
center points are easier to see.

l The Fit function now compensates for the Selection Bar and Quick Masks. The shown geometry will not longer
be obscured by the overlays.
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DESIGN ENHANCEMENTS

Listed below are enhancements to design functions.

Edit Surface and Edit Spline
Edit Spline has beenmodified to be more consistent with the Edit Surface function. The more intuitive design and
similar workflow should enhance your ability to make changes to splines and surfaces.

Multiple Node and Control Point Selection
You can now select andmanipulate multiple nodes and/or control points for Edit Surface and Edit Spline. Press
[Ctrl+click] to select multiple nodes and control points. Press [Enter] to begin editing.

Gnomon Control
Mastercam2020 gives you greater control of gnomon alignment when you edit node and control points in the XYZ
mode of the binormal plane. Select a node or control point to align the gnomon normal to the surface, spline (default),
or to the Cplane.

Curvature Comb
The sliding scale used to control the curvature comb in previousMastercam versions has been replaced. InMastercam
2020, control the display of the curvature vectors by entering a Scale value. You can also control comb spacing with
the newChord height andNumber options.

Curvature combs represent the curvature of the surface. They display curvature continuity or discontinuity.
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Hole Table
Hole Table, which was previously an add-in in previousMastercam releases, is now integrated withMastercamand has
been improved. Select Hole Table on the Drafting tab to use this new function.
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Hole Table creates parameter notes for all holes (circles) in your part file, allowing you to gather hole data and record
it in a table for part inspection. In previousMastercam releases, it was limited to finding hole geometry only on the
active plane and only recognized wireframe geometry.

Selection
As an add-in, Hole Table automatically recognized wireframe hole geometry. Now, Hole Table requires you to select
geometry, but the type of geometry you can select has expanded to include wireframe, faces, edges, and bodies. You
can filter your selection to any combination of these types, as well as individually remove a selection. Additionally, you
can control the direction of each selected hole.

Display and Position
You can define the scope, size, and position of the table and labels describing the hole geometry. You can describe the
holes in radii or diameters. You can also add location coordinates (in 2D and 3D) for each hole relative to the
origin/world Cplane, Tplane, andWCS.

On the Advanced tab, you can showor hide the hole table and direction arrows in the graphics window.

Reporting
You can create a report directly fromHole Table by selecting Create under the Active Reports group.

TrueType® Fonts
Mastercamnow supports single-stroke TrueType fonts for Create Letters (on theWireframe tab) and Note (on the
Drafting tab).

Mastercamalso includes a new single-stroke font called OLF Simple Sans CJK OC. This font is similar to Arial and has
over 35,000 characters including 400 glyphs supporting English and Romance languages, 200 Cyrillic characters, 300
Greek/Coptic characters, 70 Hebrew characters, several hundred accented Latin characters, and over 33,000
Chinese, Japanese, and Korean characters.

What's New in Mastercam 2020—Design Enhancements

44



45

Model Prep Enhancements
Listed below are enhancementsmade to Model Prep functions.

Add History
Find Features has been renamed Add History. This newname reflects the enhancements that have beenmade to the
function for Mastercam2020.

Add History now creates hole operations, which were introduced inMastercam2019. When you select the Hole
operations option, holes in a selected solid without history are recognized and saved in a newHole operation. The
Hole operation then displays in the SolidsManager.

Additionally, Add History now supports the selection of multiple bodies.

Align to Face
You can now slide a solid along a vector until it is within .001 inches or millimeters of the face of the target solid. Use
the gnomon tomove the solid along a vector. Press [Shift] to stop the motion when it contacts another solid face.
Press [Shift] again to allow the solid to move freely through solid faces. Additionally, Align to Face now supports
multiple undo and redo commands.

Push-Pull
You can nowuse Push-Pull to create a new solid body, instead of modifying the source solid.

l SelectMove to extend or shrink the solid body.

l Select Copy to create a newbody using the selected face as the base.
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Power Surface
The Power Surface function, located on the Surfaces tab, nowuses the same panel interface as other MastercamCAD
functions. The new interface offersmore robust tooltips to help you with each option without requiring you to open
the MastercamHelp.
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Solids Enhancements
Listed below are enhancementsmade to Solids functions.

Boolean
InMastercam2019, if the Target and Tool Bodies were selected before the panel opened, the Boolean function
panel would be in an error state. InMastercam2020, Boolean recognizes if you have pre-selected the Target, or not.
If the Target is not pre-selected, you are prompted to select one when you start the function.

Additionally, you can now select multiple Tool Bodies.

This is helpful if you are extrudingmultiple bodies, such as letters for a sign. Use window-select in the graphics
window, [Shift+click] or [Ctrl+click] in the SolidsManager to select multiple solids. Youmust select the solid body at
the top level.

Solid Hole
Mastercam2020 includesmany enhancements to the Solid Hole function.

Assign Colors

You can now assign colors to Solid Hole operations. Feature color can be saved as part of a customhole definition
when you add a hole to a Presets list. Click the Advanced tab and select Color to modify the operation.
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This enhancement is especially useful when automating drilling operations with ProDrill.

Associativity

A newoption allows you tomake Solid Hole operation positions that were created usingMastercam2019 associative.
To update operationsmade inMastercam2019, edit the Solid Hole operation, select the Advanced tab, andUpdate.

The Hole Position Associativity parameter updates fromNon-associative to Associative. Mastercam creates point
entities if no points or arc centers were associated with the original operation.

New Selection Controls

Solid Hole has two new selection controls: 

l Add AutoCursor Position: In addition to point and arc selection, you can now select a solid hole position using
the AutoCursor. Mastercam creates a point entity at any cursor or AutoCursor position.

l Remove All: Deletes all prior selections in the Position list box.

Top Chamfer Input

When you create a chamfer at the top of the holes, you can nowdirectly enter the actual chamfer size instead of
entering a percentage of the diameter.
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Wireframe Enhancements
Listed below are enhancementsmade toWireframe functions.

Curve Enhancements
Curve Slice, Curve All Edges, and Curve Flowline functions have new enhancements.

Curve All Edges

In previousMastercam versions, you could only create curves from the outer boundaries of selected solid faces. In
Mastercam2020, you can now create curves on the inner edges of selected solid faces.

Curve Flowline

Curve Flowline now creates curves that follow the surface's patch boundaries. Patch boundaries are true
representations of the underlying surface.

Curve Slice

The plane indicator that displays when using the Curve Slice function has been improved, giving a better picture of the
plane.
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Divide
The Divide function which allows you to trim or break entities graphically by dragging the mouse over themwhile
holding down the left mouse button, now includes a graphical undo. To undo a change, continue to hold the left mouse
button down andmove your mouse over the marker that Mastercamdisplays at the trim/break location. Mastercam
remembers the sequence of your trim and break actions, so you can undomore than one past action.

If you complete a divide sequence (releasing the mouse button), you still have the options to use the controls on the
Quick Access Toolbar, or [Ctrl+Z] and [Ctrl+Y] to undo or redo your actions.

Trim Functions
The different functions that were previously bundled in TrimBreak Extend are now separate functions located on the
Wireframe tab in the Modify group. The new functions are:

l Trim to Entities: Trims or extends one entity to another.

l Trim to Point: Breaks geometry at selected points on the entity.

l Modify Length (previously called Extend): Extends or trims the selected entity by an entered distance.

Additional Enhancements
Listed below are additional enhancementsmade to design functions.

l Mastercamhas been updated to use the Parasolids 31 kernel.

l A new, more efficient workflow is available for Trim by Plane and Trimby Surface/Sheet functions. The new
workflow eliminates the Solid Selection dialog box and defaults to Line as the method of specifying the
selected plane.

l Line Normal now supports arc selection. When you select an arc, Mastercam creates a line from the arc center
in the normal direction.

l When using the Join Entities function, you can nowpreview the join before selectingOK.

l You nowhave the option to create a surface when creating wireframe with Circle Center Point and Circle Edge
Point.

What's New in Mastercam 2020—Design Enhancements

50



51

MILL ENHANCEMENTS

Listed below are enhancementsmade to the Mill product. These include improvements to 2D, 3D, andMultiaxis
toolpaths.

Accelerated Finishing™ Tools
The newOval form tool and Lens barrel form tool are now available. They are listed in the Accelerated Finishing
group.

Oval form
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Lens barrel form

Additional Catalog Properties
When creating a tool, you can view amore extensive list of size properties. To access these properties, use the Mill
ToolManager to create a tool, and then select the Standard Sizes drop-down.
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Tools that display additional properties are Tap, Drill, Spot drill, Center drill, and Brad point drill. This functionality is
also available in the stand-alone ToolManager.

Hole-making Enhancements
NOTE
Youmust have aMultiaxis license to access this functionality.

The Multiaxis Drill and Circle Mill toolpaths have been removed fromMastercam2020. Helix Bore, ThreadMill, 2D
Drill, and 2D Circle Mill toolpaths nowhave multiaxis capability, accessed through the Tool Axis Control page in their
respective toolpath dialog boxes.

Additionally, if you open a file created in a previous version of Mastercam that had Entity type set to Points/Lines,
the selection now retains the lines and will display them in the Toolpath Hole Definition panel.

If you are creating a 4-axis or 5-axis toolpath, you can also access the Safety Zone page.
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On the Linking Parameter page, you can choose to calculate incremental values fromholes and lines, or calculate the
depth from the top of the holes and lines.

Toolpath Hole Definition
Selection for the Toolpath Hole Definition function panel (displayed when selecting point geometry for Mill, Router,
and CannedWire toolpaths) is improved for Mastercam2020.

The Features list nowdisplaysmore information about the selected points. InMastercam2019, the Features list only
displayed the word Point and an incremental number, for example, Point 4:
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InMastercam2020 the Features list nowdisplays the type of selection you have made and the diameter of the
selected point (if applicable):

Toolpath Hole Definition now supports the selection of solid features and lines, in addition to arcs, points, and
AutoCursor positions. When selecting features, you can [Ctrl+click] a diameter to select all matching diameters. Use
[Ctrl+Shift+click] to select only matching diameters and vectors.

The Analyze page of the System Configuration dialog box allows you to set the number of decimal places displayed
for the diameters.
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2D Enhancements
Listed below are enhancementsmade to 2D toolpath types.

Advanced Toolpath Display
Advanced Toolpath Display, located on the View tab, now supports the following wireframe toolpaths:

l Ruled

l Revolved

l Swept 2D

l Swept 3D

l Coons Patch

l Lofted

Override Geometry Diameter

A newoption, Override geometry diameter, has been added for Helix
Bore, ThreadMill, and Circle Mill toolpaths. This newoption, located on
the Cut Parameters page, allows you to override all of the selected
geometry's diameter information and forces the output to the specified
Circle diameter (Helix Bore and Circle Mill) orMajor/Minor thread
diameter (ThreadMill).

This option is only enabled when arcs, solid arcs, or cylindrical features are selected.
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Spring Passes and Overlap
Spring passes (set on theMulti Passes page) and Overlap (set on the Lead In/Out page) now correctly work
together inMastercam2020 for Contour, Pocket, Model Chamfer, and Dynamic Contour toolpaths. Overlap is applied
to the final spring pass.

In previousMastercam releases, Spring passes did not support Overlap and youwould receive an error when
generating the toolpath.

3D Enhancements
Listed below are enhancementsmade to 3D toolpath types.

Curve Support
Equal Scallop and Scallop toolpaths now include the ability to select Curves on the Toolpath Control page.

When selected, the toolpath is created outward using the curves as a starting point.
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Dragging and Dropping Toolpath Geometry
When dragging geometry fromone 3D HST operation to another in the ToolpathsManager, the pop-upmenu now
displaysmore options for copied geometry.

After dragging the geometry, select one of the following options:

l Add geometry: Adds the copied geometry to the geometry that exists in the selected operations.

l Add geometry and stock to leave values: Adds the copied geometry and their stock to leave values to the
geometry that exists in the selected operations.

l Replace geometry: Deletes the existing geometry for the selected toolpath, replacing it with the copied
geometry.

l Replace geometry and stock to leave values: Deletes the existing geometry for the selected toolpath,
replacing it with the copied geometry and its stock to leave values.

l Replace geometry for all selected operations: Deletes the existing geometry for all selected toolpaths,
replacing it with the copied geometry.

l Replace geometry and stock to leave values all selected operations: Deletes the existing geometry for all
selected toolpaths, replacing it with the copied geometry and its stock to leave values.
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New 3D Blend Toolpath
A new toolpath, Blend, has been added to the 3D High Speed suite of toolpaths. Select Blend from the 3D gallery on
theMill Toolpaths contextual tab to access this new toolpath.

Blend is based on the Surface Finish Blend toolpath; however it is faster and has a superior quality. Blend also includes
benefits such as the use of stock and holder checking. This also brings a blend-style toolpath to the Mill-Turn product.

Offset Strategy
Two newoptions, Closed offsets and Trimmed offsets, are available in the Toolpath Control page for Equal Scallop
and Scallop toolpaths.
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Closed offsets use the following options to drive the toolpath:

l Boundary chains

l Curves

l Machining geometry (outer shape only)

l Z depth (on the Steep/Shallow page)

l Angle (on the Steep/Shallow page)

The toolpath is created with closed passes. This yields a traditional Scallop toolpath. The following image shows a
toolpath with Closed offsets enabled and the blue spline as the selected Curves.

Trimmed offsets enablesMastercam to drive the toolpath from the selected Curves or the outer shape of the
Machining geometry. The toolpath is then generated across the entireMachining geometry shape, and the
resultingmotion is trimmed to the following:

l Boundary chains

l Angle (on the Steep/Shallow page)

l Z depth (on the Steep/Shallow page)
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The following image shows a toolpath with Trimmed offset enabled and the blue spline as the selected Curves.

Silhouette Boundary
A newoption, Include silhouette boundary, has been added to the Toolpath Control page.

When you select this option, Mastercamwill create a silhouette boundary around the selectedMachining geometry.
This will be used as a containment boundary in addition to any Boundary chains that you have selected. Mastercam
uses the Projected boundary smoothing tolerance option, the Contain options, and the Compensate to options
when generating the silhouette boundaries. These options are also found on the Toolpath Control page.
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Tool Containment
Tool containment options are now available for Equal Scallop and Hybrid toolpaths on the Toolpath Control page.
Select one of the following:

l Tool tip: Confines the tool center inside the containment boundary.

l Tool contact point: Confines the tool contact points inside the containment boundary. The tool center may run
outside the selected boundary, but the contact point of the tool will not.
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Z Depth Enhancements
The Steep/Shallow page has new Z depth options. The Use Z depths checkbox has been replaced by separate
checkboxes forMinimum depth andMaximum depth. This allows you to turn themon separately so you canmake
adjustments to only one option.

Mastercam 2019 Mastercam 2020

The Steep/Shallow page for Waterline, Hybrid, Area Roughing, and Dynamic OptiRough toolpaths has a newoption,
Adjust for stock to leave.

When you select Adjust for stock to leave, Mastercamadjusts the toolpath based on the values entered in the Floor
stock column forMachining geometry in theModel Geometry page by the following:

l All positive values: Mastercamuses the largest (most positive) value to adjust bothMinimum depth and
Maximum depth.

l All negative values: Mastercamuses the largest (most negative) value to adjust bothMinimum depth and
Maximum depth.

l Both positive and negative values: Mastercamuses the most positive Z value to adjust theMinimum depth and
the most negative Z value to adjust theMaximum depth.
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Multiaxis Enhancements
Listed below are enhancementsmade to Multiaxis toolpath types.

Deburr
The Deburr toolpath includes the following enhancements: 

On the Cut Pattern page, you nowhave an to option to set aClimb or Conventional cutting direction.

l Climb cuts in one direction with the tool rotating in the opposite direction of the toolmotion.

l Conventional cuts in one direction with the tool rotating in the same direction as the toolmotion.

On the Advanced Auto Edge Detection page, you can now limit the detection area by a set height or by selecting the
Limit detection area by height option and setting the necessary parameters.

Swarf Milling
A newdrop-down, Orientation, is now available on the Cut Pattern page for Swarf Milling toolpaths. This option is
helpful in the cases where you need to realign the operation's orientation fromworld Z to theWCS, Tool Plane, or
Construction Plane..

This newoption allows you to choose the plane that you want to orient the operation to. Previously, youmodified the
orientation by using the Planes page in theMultiaxis Toolpath - Swarf Milling dialog box.
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The Normal to guide curve option is also available under the Strategy drop-down on the Cut Pattern page. By
selecting this option, all edges are automatically obtained from the selected part surface when cutting.

Additional Enhancements
l Mastercam2020 includes processing speed improvements to the DynamicMill toolpath, 3D high speed
toolpath linking steps, and the 5-axis Curve toolpath.

l Mastercam2020 includes improvements to the Projected boundary smoothing tolerance option on the
Toolpath Control page.

l You can nowhave multiple Air region chains, instead of only one perMachining region for DynamicMill and
AreaMill toolpaths.
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LATHE ENHANCEMENTS

Listed below are Lathe enhancementsmade to Mastercam2020.

3D Tooling
3D tooling, which was introduced inMastercam2019, hasmany usability improvements.

l New stop-on-contact functionality whenmating insert to holder.

l New3D tool icons in tool lists to help distinguish between 3D and non-3D tools in the Lathe ToolManager.

l Auto-populating compensation point when defining 3D tools.

l New tabs to display library inserts and holders in the Lathe ToolManager.
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Insert Designer
Mastercam2020 allows you to build inserts using the new Insert Designer function panel. Insert Designer supports
ANSI and ISO parametric definitions or custom inserts based on solidmodels.
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Holder Designer
Also inMastercam2020, you can build holders using the newHolder Designer function panel. Holder Designer
supports customholders from solidmodels.

Filters for Inserts and Holders
You can now filter inserts and holders by attributes. In the Lathe ToolManager, select either Insert Filter or Holder
Filter.

Use the dialog box to filter your selections by selecting attributes you are looking for. After clickingOK, only items
that match that criteria will display in the ToolManager.
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Lathe Insert Filter dialog box:
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Lathe Holder Filter dialog box: 

Improved Chuck Jaw Definitions
Mastercam2020 includes improvements to chuck jaw definitions. Parametric jaw definitions are more powerful and
flexible. The following enhancements have been added:

l Support for pie-shaped jaws in addition to rectangular-shaped jaws.

l Define asmany steps as required, set the dimensions of each jaw individually, and add a radius to the step.

l Change the mounting orientation with easily reversible steps.
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l Live preview showing the overall shape of the jaw and its total dimensions.
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Previous versions of Mastercam limited you to a fixed set of seven possible reference positions (four outside
diameter, three inside diameter) to identify the location where the jaws clamp the part. InMastercam2020, you can
select any point on the profile. The reference point is included in the live preview of the jaws.
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MILL-TURN ENHANCEMENTS

Listed below are Mill-Turn enhancementsmade to Mastercam2020.

Improved Machine Configuration Workflow
Mastercam2020 gives youmore power for setting upmachining jobs and configuring .machine files for Mill-Turn. A
suite of new tools works together to significantly improve and streamline the Mill-Turn workflow.

New Machine Configuration Page
The Job Setup workflow has been enhanced with the addition of the newMachine Configuration page. Use this page
to select the chucks and jaws to be loaded on the machine.

l Previous versions of Mastercam required you define chuck jaws for each part. InMastercam2020, you can save
chuck jaws to a component library and re-use them inmultiple parts. You can define asmany sets of chuck jaws
as necessary.

l You can also define different chucks and save them to a component library so they can be managed together
with jaws. In previous versions of Mastercam, you were limited to the chuck that was built into the .machine file
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and only machine developers couldmake changes to the chuck. Mastercam2020 allows you to swap out chucks
for each part by selecting them from their library.

l You can select which chucks and jaws to use as defaults.

l TheMachine Configuration page also lets you enter minimumandmaximum spindle speeds directly as part of
the Job Setup. Previously, these values were saved in the machine definition and needed to be edited there.
Moving these settings to the Job Setup tabmakes it more convenient for you to enter values.

New Tool Locator and Component Library Functionality
The workflow for managing tool locators and component libraries has been reworked and is now available to all Mill-
Turn users. Now any Mill-Turn user can create or edit tool locators andmanage their tool locator libraries, instead of
being dependent on your Reseller or machine developer. You can open the component library by right-clicking on the
.mcam-gmd file in the Machine Explorer in Code Expert and selectingOpen or by double-clicking it.
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Mastercamopens the library and displays it in the newMill-Turn Component Library dialog box:

You can use the new interface to easily to do any of the following:

l Import tool locators fromother libraries.

l Create newor custom libraries.

l Create new tool stations—including half-index tool stations—or edit existing ones.

l Edit or shift the toolmounting locations on the block.

l Edit or replace the solidmodel used to simulate the locator.

l Create completely new tool locators as required.
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Many tool locator libraries are already available onMastercam’s Tech Exchange
(community.mastercam.com/TechExchange) and are available to any Mill-Turn users. The component libraries
themselves have been enhanced so that users can store chucks and chuck jaws in them. In addition, you can select the
chuck and jaws that will be used as the default for each spindle.

Thismeans you can easily store turret tool locators, spindle tool locators, chucks, and chuck jaws in the same
component library. The newMachine Configuration page ("NewMachine Configuration Page" on page 73) exposes
these components to you during Job Setup, allowing for flexibility in configuring the machines for each job.

New Interface for Local Machine Definitions
Mastercam2020 includes a new simplified interface for working with the local copy of aMill-Turnmachine definition.
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The new interface removes functions that are not relevant to editing the local copy of the machine definition, and
focuses your attention only on tasks that are appropriate for job-specific changes. It also indicates that you are
working on a local copy of the machine definition instead of the master copy.
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POST ENHANCEMENTS

Listed below are enhancementsmade to posts.

MPBin Enhancements
For Mastercam2020, the MPBINX utility has been renamedMPBin. In addition, it includes several new features.

MPBin now lets you create a single PSB file that can be used for multiple SIMs or license numbers. Previously, MPBin
would output a separate PSB for each SIM. You can still choose to output individual PSB files.

MPBin now includes the ability to enter an expiration date for the binned (encrypted) post.

MP Post Enhancements

Improved language support for post text
Mastercam2018 introduced the ability to localize post text by associating each section of post text with a Language-
Culture code (for example, en-US for United States English). The Language-Culture code is encapsulated in a
<language> tag (for example, <language>en-US</language>). However, this has created confusion when the post does
not include a post text section with a Language-Culture code that matches the user’s workstation. In these cases,
Mastercam2018 andMastercam2019 display systemdefault post text instead of the intended post text.

Mastercam2020 includesmore robust error handling so that it ismore likely that a user will see useful post text if the
proper language tag is not found. When a user loads amachine and control definition inMastercam2020, Mastercam
searches for post text in this order:
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l A post text section that matches the current control definition name plus the Language Culture Name from the
Mastercamworkstation.

l A DEFAULT post text section of the proper product type, with the proper Language Culture Name.

l An en-US post text section.

l The first post text section of any language.

l Systempost text.

For example, if a user in France loads aGeneric Haas 4-axisMill post, Mastercamwill look for the following post text
section:

<control>
<control_label>CTRL_MILL|GENERIC HAAS 4X MILL</control_label>
<language>fr-FR</language>
<misc_integers>

<misc_1>

If this section is not found, Mastercam looks for a DEFAULT post text section:

<control>
<control_label>CTRL_MILL|DEFAULT</control_label>
<language>fr-FR</language>
<misc_integers>

<misc_1>
<text>Work Coords [0-1=G92, 2=G54'S, 3=G52, 4=both]</text>
<value>2</value>

</misc_1>

If no DEFAULT post text section exists, Mastercamwill use this post text section:

<control>
<control_label>CTRL_MILL|GENERIC HAAS 4X MILL</control_label>
<language>en-US</language>
<misc_integers>

<misc_1>

If no en-US section exists, Mastercamwill use the first post text section it finds. If no post text section of any language
exists in the post, Mastercamwill use default systempost text.

Improved support for UTF-8 encoding for MP posts
Beginning inMastercam2019, MP posts (*.pst, *.mcpost, and *.set files) are encoded as UTF-8 text format. This
improves support for post text in languages other than US English. However, Code Expert inMastercam2019 did not
enforce this. Thismeans that inMastercam2019, if your Code Expert was set to use a different character encoding
scheme and you opened anMP post, it would save the post with the non-UTF-8 encoding.

For Mastercam2020, Code Expert will now respect and enforce the UTF-8 requirement for MP posts.

l If you open aMastercam2020 post in Code Expert and the post is not in UTF-8 format, Code Expert will open
and save it as a UTF-8 file.

l If Code Expert is set to use a different character encodingmethod than UTF-8 and you open aMastercam2020
post, it will still open and save it as a UTF-8 file, instead of the encoding scheme selected in Application Options
as shown above.
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l If you open aMastercam2019 or earlier post in Code Expert 2020, Code Expert will use the active character
encoding scheme that has been selected in Code Expert.

Mastercam2019 andMastercam2020 automatically convert posts to UTF-8 when youmigrate or update them from
earlier versions, but you should be aware of this distinction if you work with or support posts fromearlier Mastercam
versions.

There are two places in Code Expert where you can select a character encoding scheme. The default method is set in
the Application Options dialog box, on the Document Settings page.

The second is the Reload with Encoding command on the Home tab.
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